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Overview

« Objective 3.1: Configure and Manage
backups.
o Configure Windows Server backups
o Configure Windows Online backups
o Configure role-specific backups
o Manage VSS settings using VSSAdmin
o Create system restore points
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Backups

« When an organization loses data, the results
can range from a loss of productivity to an
enfire meltdown of the company ifself.

« Having a solid backup strategy along with
the systems, processes, and tools to execute
the strategy Is the key to your abillity to
recover.

The best method to data recovery is Backup,
Backup, Backup.

© 2013 John Wiley & Sons, Inc.



[.ost Data

* |f you've been administering servers for any
length of time, you most likely have
experienced or heard of someone who lost
data due to:

o Hardware failure
o Software failure
o Human error

o Computer virus
o Theft

o Naftural disaster (flooding, earthquakes, severe
weather, and so on)

o Fire
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Windows Server
Backup Feature

 Windows Server Backup, wbadmin, and
Windows PowerShell cmdlets provide the tools
to back up and restore your critical data and
servers.

* To run backups on Server Core installations, use
either the command-line tool wbadmin or the
Windows PowerShell cmdlets, or manage them
remotely from another computer using the
Windows Server Backup MMC.

o You can also use the Windows 8 Remote Server
Administration Tools (RSAT).
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Wbadmin

N Administrator: C:\Windows\system32\cmd.exe \;‘i-

C:slUserssadministrator . CONTOS0>whadmin ~#7 "
whadmin 1.8 - Backup command-line tool
¢G> Copyright 20012 Microsoft Corporation. All rights reserved.

———— Commands Supported ———

EMABLE BACKUP
DISABLE BACKUP
START BACKUP
STOP JOB

GET UERSIONS

GET ITEMS
START RECOUERY
GET STATUS

GET DISES

GET UIRTUALMACHINES

START SYSTEMSTATERECOUERY
START SYSTEMETATEBACKUP
DELETE SYSTEMSTATEBACKUP
DELETE BACKUP

Creates or modifies a daily backup schedule.

Dizables the scheduled backups.

Runz a one—time backup.

Stops the currently running backup or recovery
operation.

Lists details of backups that can be recovered
from a specified location.

Lists items contained in a backup.

Runz a vecovery.

Reports the status of the currently running
operation.

Lists the disks that are currently online.
Lists current Hyper—U virtual machines.

Runs a system state recovery.

Runs a system state backup.

Deletes one or more system state backups.
Deletes one or more hackups.

C:slUserssadministrator . CONTOS0
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Windows Server Backups

 The Windows Server Backup feature provides full
server, bare metal recovery, system state,
system reserved, and local/remote volume
backup capabillities.

 Recovery Time Objective (RTO). The maximum
amount of time you have to bring a system
back online before it has a significant impact
on your organization.

* Recovery Point Objective (RPO): The amount of
data you can afford to lose before it has o
significant impact on your organization.
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Backup Configuration
Options

When configuring
your backup,
select either:

» Full server
(recommended)

e Custom
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Medify Scheduled Backu...

Select Backup Configuration

What type of configuration do you want to schedule?

®) Full server (recommended)

Select Backup Configurat...

| want to back up all my server data, applications and system state.
Backup size: 14.65 GB

Specify Backup Time

Specify Destination Type .
Custom

| want to choose customn velumes, files for backup.

Confirmation

Surmmary

Choosing what to include in a backup
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Custom Backup
Configuration

 The Custom opfion allows you to specity the
Ifems you want to back up. The options
Include:

o Bare metal recovery: Recover your server from @
hard drive failure to a machine running the
same/different hardware.

* |t does not support cross-architecture (x86 to
x64) and requires Windows Server installation
media to start the recovery process.

|t automatically includes system state, system
reserved, and the critical volumes that are
necessary for the operating system to run.
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Custom Backup
Configuration

o System state: Backs up all the files needed to recover
Active Directory, including the registry, boot files, the
COM+ class registration database, the Active
Directory database (ntds.dit) and its associated log
files, the Active Directory Certificate Services
database, the SYSVOL folder, and system files under
the protection of Windows Resource protection.

o System reserved: Contains the Windows Recovery
Environment (WINRE) files and can be used to boot
the server in situations where the operating system
becomes corrupted or fails to boot.

o Local disk (x:): Represents local disks and volumes on
the server.
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Manual Backups

 YOu can run a manual backup (one-time
backup) by using the Backup Once Wizard,
which can be accessed via the Actions
pane in the Windows Server Backup
console.

« These types of backups can also be inifiated
using wbadmin and Windows PowerShell.

 Never use manual backups as a

replacement for your regularly scheduled
backup.
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Storing the Backups

Windows Server Backup provides three opftions
to select from when deciding where to store
your backups. These options include backing
up fo:

o Hard disk(s) (recommended)

o A volume

o A shared network folder
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Backup Folder
and File Structure

 When your backup starts, Windows Server
Backup creates a folder structure in the
target location you specified:
o Backup <Date> <ID number>
o Catalog
o Logs
o SPPMetadataCache
o MedialD

« The Catalog folder contains information
about the volumes backed up and where
your backups are stored.
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Full versus Incremental

« After the first full backup, you can then
automatically run incremental backups,
which saves only the data that has
changed from the last backup.

* By default, Windows Server Backup creates
Incremental backups, which function much
like full backups, allowing you to restore from
a single backup.

o In the past, you had to restore a full backup
followed by the necessary incremental
backup(s) To complete the restore process.

© 2013 John Wiley & Sons, Inc. 15



Optimizing Backups
 Windows Server Backup also provides
performance enhancements by using block-

level technology and Volume Shadow Copy
Service (VSS).

» Block-level backup technology improves
performance by bypassing the files and file
system.

* Volume Shadow Copy Service (VSS) takes a
snapshot of the volume’s current data, which is
used by Windows Server Backup to back up the
data. The snapshot, or shadow copy, Is then
deleted when the backup completes.
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Optimizing Backups

B Optimize Backup Performance

if your backups contain full volumes, you can manage future perfformance by
choosing one of the following settings. If the backup contains anby the system state
or a file or folder, these settings are not applied.

® Mormal backup perfformance

The time to create the backup is proportional to the size of the data being
backed up.

() Faster backup peformance
Increase the backup speed by just tracking the changes between the last and

cument backup. This might reduce disk throughput on volumes included in the
backup. This option iz not recommended for servers with disk-ntensive

operations.
() Custom
Configure each volume separately if you have certain volumes that have
disk-4rtensive operations.
Wolume Backup Option
System Reserved Full backup
Local disk (C:) Full backup
CompData (E) Full backup W

OK || Canesl
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Windows Azure
Online Backup

« Storing your backups in the cloud allows you o
retrieve them from any location where you
have Internet access and provides you with an
offsite storage location to protect against
disasters.

 Windows Azure Online Backup is a Windows
Server 2012 feature that allows you 1o back up
your files and folders to the Windows Azure
Online Backup service.

« Windows Azure is a cloud-based storage service
managed by Microsoft.
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Windows Azure
Online Backup

File Action View Help

&= 7m 3=

Windows Server Backup (1 3 3 ~ | Actions
W & Windows Azure Online Backup
@ Local Backup -
e A _ _ folnline Raclonn
s £ @ Windows Azure Online Backup supports scheduled backups of files and folders to an Register Server
Open Portal
@ Click on "Register Server” in the Actions pane to register server using your Windows Azure Online Backup accou )
About Windows Azure ...
5 Privacy 8 Cockies
View >
n Help
b
< m >l < m >
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Optimizing Online
Backups

* During the backup process, Windows uses

your network along with Internet bandwidth.

« Just as with any backup, it's always a good
idea to run it outside of your normal work
hours. If that is not an option, you can make
some adjustments to control how the
Windows Azure Backup Agent uses the
bandwidth during certain days and fimes.
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iIndows Azure Online
ackup Properties

e
m Windows Server Backup (| indowc A7iira Minlina Bacloin ~ | | Actions
@ Local Backup _ .
& Online Backup | Online Backup ~ +
N or Register Senver

| Encryption | Prosey Configuration | Throttling

Schedule Backup

%

i
[] Enable intemet bandwidth usage throttling for backup operations 5 BackUp Now
a

Recover Data

Waorlc hours: |255.D = | | Kbps | Change Properties
Non-work hours: |‘ID23.D :||Mbpg | Unregister Server
- Open Portal
Work hours: | 9 AM | | 5PM | )
About Windows Azure ..,
Work days: [ Sunday Monday Tuesday Wednesday Thursday = 9 Privacy & Cookies
Fiday [ | Saturday View »
Help

regular scheduled backup is configured for this server, Destination usage reflects how the backups from this server are sto
pdated on a daily basis; recent backups might not be included in this calculation,

Settinns Nestinatinn usane
< m > <l ] m [ >

Change Properties.
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Backing Up DHCP

 The Dynamic Host Configuration Protocol
(DHCP) database contains information
about IP address leases, reservations,
scopes, scope options, and DHCP registry
key settings.

* |t's backed up automatically at 60-minute
Infervals to the
%systemroot%\System32\Dhcp\Backup
directory. It is also backed up as part of a
system state or full backup and by using the
DHCP Manager console.
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Backing Up DNS

« Active Directory-integrated DNS zone configuration
iInformation is stored in the registry; therefore, it's
also backed up as part of the system state and
during full backups.

* An alternative is to use DNSCMD with the
/zoneexport switch to export the Active Directory-
infegrated zones to a file you can back up:

DNSCMD /zoneexport contoso.com
\backup\contoso.com.dns.bak

« The XCOPY command can be used to back up
primary and secondary zone files to a backup
folder you specify:

XCOPY %systemroot%\system32\dns c:\backups\dns /y
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Backing Up WINS

 The Windows Intfernet Name Service (WINS)
maintains a distributed database used to
register and query dynamic mappings of
NetBIOS names for computers and groups.

* It maps NetBIOS names to IP addresses.

« Although the database is backed as part of
system state and full backups, you can also
back up the WINS database from the WINS

console.
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Backing Up
Certificate Services

 Certificate Services stores a database in the
C:AWindows\system32\Certlog location by
default.

« When certificates are issued to users and
computers, the associated information is
maintained in the Certificate Services
database.
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Backing Up Active Directory
Domain Services

Active Directory is backed up as part of
system state and full backups. These
components are included in the system state:

o System startup (boot) files

o System registry

o COM+ Class registration database

o System volume (SYSVOL)

o Active Directory
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Active Directory
Recycle Bin

* To use Active Directory Recycle Bin, your
forest functional level should be set to at
east Windows Server 2008 R2 or greater and
all domain controllers must be running
Windows Server 2008 R2 or Windows Server

2012.
« This can be confirmed by selecting Server

Manager > Tools > Active Directory
Administrative Center.
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Protecting Active Directory
Objects from Deletion

» To further protect against the accidental
deletfion of objects in Active Directory
(Computers, OUs, and Users), Windows
Server 2012 provides the “protect from
accidental deletion” opftion.

» This setting can be found by opening the
Active Directory Administration Center, right-
clicking the object, and selecting Properfies.
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VSS Settings and
VSSAdmin

* Use the Volume Shadow Copy
Administrative Command-line Tool
(VSSAdmin) to

o Create and delete volume shadow
copies/associations.

o List shadow copy providers and writers.

o Resize a volume shadow storage association.,

* VSSAdmin is used to manage VSS.
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V55 Components

* The VSS components communicate with
each other via the VSS Framework to both
create and restore your shadow copies.
These are the tasks performed by each
component:

o V8S requester

o VSS writer

o VS8S provider

o Source volume
o Storage volume

© 2013 John Wiley & Sons, Inc.
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Creating System

Restore Points

« Shadow Copies for Shared Volumes (SCSV)
and Hyper-V snapshots provide you with the
ability to return to a specific point in fime.

* You enable SCSV on a per-volume basis by
selecting Server Manager > Tools >
Computer Management.

* You need at least 300 MB of free space 1o
create a shadow copy on the selected
volume.
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Shadow
Shared

;{. Computer Management (Local
A [fj System Tools
I+ @ Task Scheduler
I 2] Event Viewer
[ za| Shared Folders
i & Local Users and Groups
I+ @ Performance
=y Device Manager
4 23 Storage
[ -@ Windows Server Backug
=¥ Disk Management
[ :=J¢ Services and Applications

Volume

Copies for

Volumes

I Layoutl Typel File Systermn I Status

= (5)
= CorpData (E:)
w System Reserved

Simple Basic NTFS

== Backup (E:) Properties
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| General | Tools I Hardware | Sharing | Security

Shadow Copies | Previous Versions I Quota | Customize

Shadow copies allow users to view the contents of shared folders
as the contents existed &t previous points in time. For information on
Shadow Copies, click here.

Select a volume:
Volume MNext Run Time  Shares Used
== PVl Disabled 1] [ bytes an ...
R 2723 T0. 0 488 MBon ...
FEN 27201370 0 227GHBon ...
<|
Enable Disable | | Settings... |
i Disk 0 .
Basic System 'ﬁ Shadow copies of selected volume
I 350 MB N 2/6/2013 1:33PM Create Now
Online Healthy (¢
Delete Mow
5]
=wCD-ROM 0 i
Revert ..
DVD (D) e
Mo Media
ok || Cancel Apply

Healthy (Boot, Page File, Crash Dump, Pri

v Partition
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Backing Up Hyper-V
Virtual Machines

« VMs, created using Hyper-V, are stored as files
on your hard disk.

o These files contain the VHDs, saved state files,
snapshot files, and configuration files.

« VSS writers are responsible for preparing their
data in order to make the shadow copy and
are instructed by VSS to quiesce (pause) ifs
associated application to ensure a consistent
backup is made.

* By using the Microsoft Hyper-V VSS writer,
Windows Server Backup can create the
snapshots while the VM is running.
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Hyper-V Snapshots

Hyper-V snapshots offer another way to capture the state,
data, and hardware configurations for a VM at a specific
point in time.

These snapshots, which can be taken when the VM is running
or stopped, are created in the Hyper-V Manager.

The snapshot includes the configuration and network settings
for the VM as well as the current state of the VHD(s) attached
to the machine and any saved state information.

Hyper-V uses the VSS to make a copy of the guest machine’s
hard disk.

By default, a Hyper-V snapshot’s data is stored in an
automatic VHD (.avhd) file and then it's attached to the VM.

When you take a snapshot of a VM, you are basically
converting its VHD info a differencing disk.

© 2013 John Wiley & Sons, Inc.
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Exploring Enterprise
Backup Solutions

 |f you are looking for an enterprise backup
solution, then consider System Center 2012 Data
Protection Manager:
o It provides the ability to back up to disk and to tape.

o It can be used to protect and recover Exchange
(2007, 2010, 2013), SQL (2008, 2008 R2, 2012),
SharePoint (2013, 2010), Windows SharePoint Server
3.0, Microsoft Office SharePoint Server 2007, Windows
desktops/laptops (Windows 7/8, Windows Vista),
virtual servers (Hyper-V Windows Server 2008/2008 R2,
Windows Server 2012), and file servers (Windows
Server 2008/2008 R2, Windows Server 2012) within and
across Active Directory domains.
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Exploring Enterprise

Backup Solutions

 DPM also provides you with the ability to
manage system state and bare metal
recovery from a cenftral location.

* The following vendors provide enterprise
backup solutions for Windows Server 2012:
o Acronis Backup and Restore
o Symantec Backup Exec 2012 and NetBackup
o IBM Tivoli Storage Manager
o Carbonite
o CA Technologies ARCserve
o Commvault Simpana
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Lesson Summary

Hardware/software failures, human error, computer viruses,
theft, natural disasters, and fire can result in data loss;
therefore, you need to have a backup strategy in place and
be prepared to execute if.

When the Windows Server Backup feature is installed, it
includes the Windows Server Backup console, wbadmin, and
Windows PowerShell cmdlets that can be used to back up
yOur server.

Windows Server Backup on Windows Server 2012 does not
support backing up to tape, but you can still use System
Center 2012 Data Protection (DPM) Manager to perform a
disk-to-disk-to-tape (D2D2T) and third-party software if
necessary.
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Lesson Summary

« Windows Server Backup offers both full server
(recommended) and custom backup
configuration options. Custom options include
bare metal recovery, system state, system
reserved, and local disk.

 Bare metal recovery backups can be used to
recover your server from a hard drive failure to
a machine running the same/different
hardware, but it does not support cross-
architecture (x86 to xé64) restores.

 Manual backups should not be a replacement
for regularly scheduled backups.
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Lesson Summary

 Windows Server provides three options when
deciding where 1o store your backups: hard disk,
volumes, and shared network folders. When
backing up to hard disk, the best practice is to
dedicate them to the Windows Server Backup job
set and use a rotation schedule to take disks offsite
for additional protection.

« Backups to shared network folders are overwritten
with each subsequent backup.

« Backups are stored in a WindowsimageBackup
folder under the name of the server being backed
up (e.g.,
\\<server>\<sharedfolderpath>\WindowslmageBa
ckup\<serverbackedup>).
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Lesson Summary

Backup performance is enhanced through the use of
block-level technology and Volume Shadow Copy
Service (VSS). Block-level technology bypasses the files
and file system and reads the blocks in the order they
appear on the disk. VSS takes snapshots of the volume’s
current data allowing users and applications to contfinue
to use the volume without interruption.

Backups of full server volumes can be optimized by
selecting the faster backup performance setting
(incremental backups) available in the Configure
Performance Settings.

File classification allows you to configure automatic
procedures for defining a desired property on a file,
based on the conditions specified in classification rules.
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Lesson Summary

Windows Online Backups, a feature available with
Windows Server 2012, allows you to back up your files

and folders to the Windows Azure Online Backup service.

It does not support system drivers/system state backups.

This involves setting up a Windows Azure Online account,

installing a software agent, registering the server, and
then scheduling the backup to occur. You can also
monitor the health of the online service with the
Windows Azure dashboard.

As part of your overall backup strategy, take info
consideration the roles installed on each of your servers.
Depending on the roles performed, how you approach
the backup and eventuadlly restore the system may be
impacted.
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Lesson Summary

 The Volume Shadow Copy Administrative
Command-line tool (VSSAdmin) can be used to
manage VSS. VSS consists of VSS requesters, writers,
and providers that work with each other using the
VSS Framework.

« Shadow Copies for Shared Volumes (SCSV) uses the
capability of VSS to capture and store copies of
folders located on shared network resources at a
specific point in fime. End users can use these to
restore their own files, which can reduce the time
and costs associated with file recovery.

« Hyper-V snapshots can be used to capture the
state, data, and hardware configurations for a
virtual machine (VM) at a specific point in fime.
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